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Introduction

Management Reporter 2012 for Microsoft Dynamics® ERP uses a data mart adapter to integrate data
between Microsoft Dynamics® SL and Management Reporter. You can view and work with data from
Microsoft Dynamics SL to create financial reports in Management Reporter 2012 without affecting the
original data in the ERP database.

Note:

The Microsoft Dynamics SL data mart adapter replaces the Microsoft Dynamics SL legacy data
provider with Management Reporter 2012 RU4 and later versions. The Microsoft Dynamics SL
legacy data provider remains compatible with Management Reporter 2012 RU5 and later versions.
Earlier versions of Management Reporter must be updated to Management Reporter 2012.

This version of the Microsoft Dynamics SL data mart adapter is compatible with Microsoft
Dynamics SL 2011 and later versions.

The Microsoft Dynamics SL data mart adapter supports one system database per integration and
lets you specify a starting fiscal year limit. This option improves report generation in Management
Reporter 2012.

The Microsoft Dynamics SL legacy data provider included with Management Reporter 2012 RU5
and later versions lets users run existing reports and also remove existing integrations. We
recommend that you remove existing Microsoft Dynamics SL legacy data provider integrations and
configure a Microsoft Dynamics SL data mart integration with Management Reporter 2012 RU5 and
later versions.

New Microsoft Dynamics SL legacy data provider integrations are not supported beginning with
Management Reporter 2012 CU13.
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Upgrade Considerations

When you upgrade to the Microsoft Dynamics SL data mart adapter, you may notice several
differences. This section identifies these areas and explains the differences and reasoning behind
them.

Microsoft SQL Server Version Support Change

Beginning with Management Reporter 2012 Cumulative Update 15 (CU15), the SQL server that is
hosting the Management Reporter databases must be on Microsoft SQL Server 2012 RTM or higher.
SQL versions prior to Microsoft SQL Server 2012 RTM are no longer supported and must be upgraded.
For further information, see System requirements for Management Reporter.

New Ability to Limit the Integrated Companies

With Management Reporter 2012 Cumulative Update 11 (CU11) and later versions, you can limit the
companies that will be integrated to the data mart. Select the new Exclude from MR check box (grid
view) or the Excluded from Management Reporter Integration check box (form view) in the
Company Maintenance (98.280.00) screen in Microsoft Dynamics SL to exclude a company from being
integrated with Management Reporter. To see this check box, you must install hotfix 34694 for
Microsoft Dynamics SL 2015 or earlier versions (Microsoft Dynamics SL 2015 CU1 contains this
correction). Download the hotfix, if applicable, from the following Knowledge Base article:
https://mbs.microsoft.com/knowledgebase/KBDisplay.aspx?scid=kb;EN-US;3022697

Choose the version of the hotfix that corresponds to the version of Microsoft Dynamics SL that you
have installed.

You must do this before you enable the integration.

ERP Data Validation

For data mart integrations of Management Reporter, the Configuration Console lets you validate
Microsoft Dynamics SL data for inconsistent or invalid data. The validation checks for the inconsistent
and invalid data within the ERP which cause problems with Management Reporter. If the validation
finds problems, an error in the integration log has you run additional scripts located on the Microsoft
Knowledgebase at http://go.microsoft.com/fwlink/?LinkId=398540.

New Ability to Limit the Data Integration Timeframe

With Management Reporter 2012 Cumulative Update 8 (CU8) and later versions, you can limit the
amount of financial data from Microsoft Dynamics SL that is integrated with the Management Reporter
data mart. You can limit the starting fiscal year for a single Microsoft Dynamics SL application
database or for all Microsoft Dynamics SL databases.

You must do this before you enable the integration.
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To limit a single Microsoft Dynamics SL application database, follow these steps:
1. Log on to SQL Server Management Studio, open a query window, and then select the database.

2. Paste the following into the query window.

IF EXISTS (SELECT * FROM sysobjects WHERE id =

OBJECT ID('dbo.Get MR FiscalYear Start'))

DROP Procedure dbo.Get MR FiscalYear Start
GO
Create Proc Get MR FiscalYear Start as
Select '2009°

GO

Grant Execute on [Get MR FiscalYear Start] to [E8F575915A2E4897A517779CODD7CE] GO
3. Change the year shown to the start fiscal year limit that you want to specify. For example, if you

specify 2009, the Management Reporter reports will include data from fiscal year 2009 and later.

4. Run the SQL statement.

To limit all Microsoft Dynamics SL databases, follow these steps:

1. Locate the MRServiceHost.settings.config file, and then edit the file in Notepad. The default
location of the file is <Program Files>\Microsoft Dynamics ERP\Management
Reporter\2.1\Server\Services.

Note: You must install the Management Reporter Server component first.

2. Add a line that resembles the following.
<add key="IntegrationFiscalYearStart" value="2009" />

3. Change the year shown to the start fiscal year limit that you want to specify. For example, if you
specify 2009, the Management Reporter reports will include data from fiscal year 2009 and later.

4. Save the changes to the MRServiceHost.settings.config file.

System Database Method of Integration

With Management Reporter 2012 Cumulative Update 7 (CU7) and later versions, all the prior data
mart integrations associated with a Microsoft Dynamics SL installation are unsupported. You must
remove your existing application database based integrations and reconfigure them by using the
method that integrates to the Microsoft Dynamics SL system database. Prior integrations were based
on the Microsoft Dynamics SL application database.

When integrating a Microsoft Dynamics SL system database, all companies in that system database
are integrated, and are available for reporting.

The Account Category and Account Type Attributes

These attributes are built into Management Reporter and are duplicates of the Acct_Cat and AcctType
attributes.
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Drill to Dynamics

When drilling into Microsoft Dynamics SL the Microsoft Dynamics SL Account/Subaccount Detail
Inquiry (01.303.00) screen is loaded based on the context of the report. With the provider the data
passed to the screen used a period range specific to the report data. The adapter implementation uses
the Management Reporter Data Mart Adapter, and that adapter passes data representing the range of
fiscal periods from 01 to the report’s base Fiscal Period. You may see different data loaded into the
screen when you use Management Reporter 2012 RU5 and later versions and the data mart adapter.

When you use Microsoft Dynamics SL 2015 with Management Reporter 2012, you must install hotfix
34515 (Microsoft Dynamics SL 2015 CU1 contains this correction). Download the hotfix from the
following Knowledge Base article:
https://mbs.microsoft.com/knowledgebase/KBDisplay.aspx?scid=kb;EN-US;3026634

Use of Wildcard Characters in Filters

The legacy data provider used Accounts and other ID type fields that had space padding on the end.
For example, a filter like 1?7??? found values like "1030 " in addition to "10301.” The adapter does not
use space padding. A filter like 1?7?72 will not find “1030” but will find *10301.” This is also true for
filtering on IDs like Ledger ID and Dimension Data, not just the Account ID.

Filtering on Dimensions

If any Microsoft Dynamics SL subaccounts are set up in Flexkey Definition (21.320.00) to allow for
blank-filled segments, when you filter on that dimension in Management Reporter, you must use the
word “blank” instead of spaces. For example, the subaccount used in a transaction is 00-000- -00000.
If you want to use Management Reporter to filter on this third segment to locate this transaction, you
can either type “blank” or select “blank” from the possible values list. The other possible values in this
list contain the valid values for the segment specified in Flexkey Table Maintenance (21.330.00) and
any values that were used in transactions.

Exporting and Converting Report Definitions

We recommend that you export your Report Definitions and their related Row Definitions, Column
Definitions, Reporting Tree Definitions, and Dimension Value Sets before you start the upgrade
process to Management Reporter 2012 RU5 and later versions.

The Report Definitions and their related Row Definitions that were created by using the legacy data
provider must be converted in order to work with the new data mart adapter. Follow the instructions in
the following Knowledge Base article:

Management Reporter 2012 report may return no data after you change to Dynamics SL Data
Mart Provider https://mbs.microsoft.com/knowledgebase/KBDisplay.aspx?scid=kb;EN-
US;2807488

Prompting for Credentials
You may notice that you are less frequently prompted for credentials when you change companies.

The Microsoft Dynamics SL Legacy Data Provider

If you currently integrate with Microsoft Dynamics SL by using the legacy data provider, we
recommend that you create a new integration by using the data mart adapter. New Microsoft
Dynamics SL legacy data provider integrations are not supported beginning with Management
Reporter 2012 CU13.
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Upgrading to Management Reporter 2012

When the upgrade to Management Reporter 2012 is complete, you see the following prompt to run the
Configuration Console.

|,§ Management Reporter Server Setup x|

M Microsoft Completed Management Reporter setup.
Dynamics

Click the Finish button to exit setup.

[V Sstart the Configuration Console to continue

Back | Finish I Gance| I

1. Select Start the Configuration Console to continue, and then click Finish.

Note: The "Unable to connect to the Management Reporter application service. Make sure the service
is started. See the service log for details.” message may incorrectly appear. Click OK to continue
with the upgrade.

The Management Reporter 2012 Configuration Console appears.

Ji Management Reporter 2012 Configuration Console B -1of x|
File Help
= § Management Reporter Services .
3§ Companies Fb Management Reporter Services
Bl 4 ERP Integrations H -
SQLSRVR 105 (DemoSystem) to SQLSRVR 105 (ManagementReporterDM) N
a b’ Logs" Q (BemoSystem) to SQU anag s " ~ Management Reporter Services
3
§ Data Mart Integration
g\ Deployment { } ) Management Reporter 2012 Application Service - Funning Remove Application Service
@ service Start/el, 1Stogy | Reskact Remove Process Service
( x “ Management Reporter 2012 Process Service - Stopped
3 Start | S Restart
Database connection:
SQLSRVR 105 (ManagementReporter)
Service account:
Contoso\TUser 1
~ Companies
Description Name  Source System
Graphic Design Institute:Demo| 0010 | Management Reporter data mart
Humongous Insurance:Demo | 0020 | Management Reporter data mart
Contoso, Ltd:Demo 0060 Management Reporter data mart
Coho Vineyard:Demo 0070 Management Reporter data mart
Coho Winery:Demo 0080 | Management Reporter data mart
Refresh Companies|
Task List ~ ERP Integrations
T — e Select Configure from the File menu to add additional ERP integrations.
b A t t
The integration to the data mart database '"ManagementReporterDM' on server
'SOLSRVR 105' needs to be updated. _.]

MANAGEMENT REPORTER INTEGRATION GUIDE FOR MICROSOFT DYNAMICS® SL



2.

In the Task List pane, click the Update the Management Reporter database link, and then

answer the prompts for credentials to run the update. For more information about credentials, see
“User Account Requirements” on page 10.

Note: The Task List may incorrectly display the "Unable to connect to the application service to
retrieve configured ERP migrations. Click here to try again.” even when you see that the
application service is running. You can ignore this message and continue with these steps.

When the process is complete, the following confirmation message appears.

Management Reporter 2012

The database was updated successfully and the application service has been

restarted.

1 x|

Click OK.
The Task List changes.

it Management Reporter 2012 Configuration Console
File Help
= § Management Reporter Services

i) companies

El |4 ERP Integrations
4 SQLSRVR105 (DemoSystem) to SQLSRVR 105 (ManagementReporterDM)

2 § Logs

B Data Mart Integration

& Deployment

B senice

Task List

The integration to the data mart database 'ManagementReporterDM'’ on server
'SQLSRVR 105' needs to be updated.

= =lolx]|

Fb Management Reporter Services

~ Management Reporter Services

Reporter 2012
Stop Restart

ion Service - Running

Remove Application Service
Remove Process Service

( x ) Management Reporter 2012 Process Service - Stopped
a Start | S Restart

Database connection:

SQLSRVR 105 (ManagementReporter)
Service account:

Contoso\TUser 1

~ Companies

Unable to connect to the Management Reporter application service at http://sqlsrvr 105:4712
‘ Description  Name  Source System

Refresh Companies’

~ ERP Integrations

Select Configure from tne File menu to add additional ERP integrations.

]

If your existing integration is a data mart integration, click the The integration to the data mart
database ‘datamartdatabasename’' on server ‘sqlservername’ needs to be updated link in

the Task List pane.

Enter the credentials for SQL Server Change Tracking, and then click OK. For more information,
see “Enable SQL Server Change Tracking” on page 10.

Answer the prompts for credentials to run the Database Update and click Update. For more
information about credentials, see “User Account Requirements” on page 10.

Click OK to the message “The database was updated successfully.”
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8. If your existing integration is a data mart integration that was integrated to an application
database in a previous version of Management Reporter or you want to switch from a legacy data
provider integration to a data mart integration, you must remove the existing integrations. See the
steps in the "Remove an Integration” topic on page 18. Then configure the data mart integration.
See the steps in the “Configure the Data Integration” topic on page 11.

Note: If you have multiple integrations for different companies from the same Microsoft Dynamics
SL system database, each integration must be removed. All companies from the same Microsoft
Dynamics SL system database will be integrated into one new data mart database when the
integration is reconfigured.

9. Start the Management Reporter 2012 Process Service.

10. Close the Management Reporter 2012 Configuration Console window.

10
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System setup

Before you configure the Microsoft Dynamics SL data mart adapter, your system must meet the
minimum requirements for Management Reporter 2012. For more information, see System
requirements for Management Reporter. Additional prerequisites are listed here.

System Prerequisites

The following prerequisites must be met before the data mart adapter can be installed on your
system:

Management Reporter server components

The Management Reporter application service or process service must be installed on the same
computer(s) where the Microsoft Dynamics SL data mart adapter will be installed. To install these
components, see the Management Reporter installation guide.

Enable SQL Server Change Tracking

Management Reporter 2012 RUS5 and later versions use SQL Server Change Tracking to make sure
that all transactions are integrated from Microsoft Dynamics SL to the Management Reporter data
mart. SQL Server Change tracking is turned on with a default retention setting of three days. If the
Management Reporter data mart integration is disabled for more than three days while transactions
are posted in Microsoft Dynamics SL, you should reset your data mart to make sure no data is missed.

During the upgrade process, the Configuration Console enables SQL Server Change Tracking. You
might be prompted to provide credentials that have sufficient permissions to enable SQL Server
Change Tracking, such as a user who has a role of db_owner or a system administrator.

Note:

+ The "ReportUser" SQL Login account is changed to include the View Change Tracking permission to
read the change tracking tables in Microsoft Dynamics SL.

For more information about SQL Server Change Tracking, see the following MSDN articles:

+  “How to: Use SQL Server Change Tracking” at http://go.microsoft.com/fwlink/p/?LinkId=294714

« “Change Tracking” at http://go.microsoft.com/fwlink/p/?LinkId=294715.

» During the upgrade process, if SQL Server Change Tracking was currently not enabled, the
Configuration Console resets the data mart for Microsoft Dynamics SL and performs the initial
integration again.

+ When you add a new company to an already integrated Microsoft Dynamics SL system database,

you must reconfigure Change Tracking. In the Configuration Console for Management Reporter,
highlight the integration, and then click the Reconfigure Change Tracking link.

11
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User Account Requirements
The user account that is used during installation for the data mart adapter must:

Application Permissions required

Microsoft Dynamics SL « Have an active user account in Microsoft Dynamics SL.
» Have Active Directory domain credentials (user ID and password) to log
on to Microsoft Dynamics SL.

Management Reporter * Be a user assigned to the Administrator role.
* Have an Active Directory domain account user ID and password.

You must set up user account permissions in Microsoft Dynamics SL before you configure Management
Reporter services. When you configure the Management Reporter services, you must make sure that
the account specified in the Log On properties for the service has sufficient access to the Microsoft
Dynamics SL databases. For Windows Authenticated Microsoft Dynamics SL databases, set up a
Microsoft Dynamics SL user who is associated with the Active Directory domain account that is used by
the services. For SQL Authenticated databases use a domain account that has a SQL login already
associated with it on the SQL Server that is hosting the Microsoft Dynamics SL databases.

When you start Management Reporter 2012, you are prompted to log on to an existing company.
Active Directory domain credentials are required. The provider and data mart adapter use these
credentials to connect to Microsoft Dynamics SL databases. For more information, see “How to create
a domain account in Active Directory” on MSDN (http://go.microsoft.com/fwlink/p/?LinkId=294717).

After you have installed and fully configured Management Reporter, you can add users and change
security permissions. For more information, see the Management Reporter Help documentation.

12
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Installing and Configuring the Data Integration

The data mart adapter for Microsoft Dynamics SL is installed at the same time as the Management
Reporter server components. Install the Management Reporter Server components before you perform
the steps that follow to configure the data integration and import the company information. For more
information and installation procedures, see the Management Reporter installation guide.

Configure the Data Integration

Management Reporter uses a data mart adapter to integrate information from a Microsoft Dynamics SL
system. You can configure these components during initial configuration or after you have set up the
application service and process for Management Reporter 2012.

Note: Management Reporter 2012 can integrate with multiple ERP systems. However, you can
configure only one instance at a time.

1. Click Start, select Programs, select Microsoft Dynamics, select Management Reporter 2012,
and then select Configuration Console to open the Management Reporter Configuration Console.

2. In the Management Reporter 2012 Configuration Console, on the File menu, select Configure to
open the Custom Configuration dialog box.

Note: This screen opens automatically the first time that you open Configuration Console.

3. Under Management Reporter Application Service, click to select one of the following check
boxes for integration:

Add Microsoft Dynamics SL Data Mart - Configure a data mart integration for Microsoft
Dynamics SL and create a data mart database.

Note: New Microsoft Dynamics SL legacy data provider integrations are not supported beginning
with Management Reporter 2012 CU13. We recommend that you use a data mart integration.

il Configure Management Reporter N — Dl_)ﬂ

Custom Configuration

Select the items to configure:

El [V Management Reporter Application Service
[™ Add Microsoft Dynamics AX 2009
[~ Add Microsoft Dynamics AX 2012 Data Mart
I™ Add Microsoft Dynamics GP Data Mart
[~ Add Microsoft Dynamics GP Legacy
[ Add Microsoft Dynamics NAV Data Mart
[¥! Add Microsoft Dynamics SL Data Mart

[V Management Reporter Process Service

uextlmell

13

MANAGEMENT REPORTER INTEGRATION GUIDE FOR MICROSOFT DYNAMICS® SL


http://go.microsoft.com/fwlink/?LinkID=162565
http://go.microsoft.com/fwlink/?LinkID=162565
http://go.microsoft.com/fwlink/?LinkID=162565
http://go.microsoft.com/fwlink/?LinkID=162565

4. Click Next.

5. On the Prerequisite Validation page, review any failed prerequisites or warnings and resolve
issues before you continue with the installation process. Click Revalidate to run the validation
again.

Note: If you do not use Microsoft Excel for reporting, you do not have to install the prerequisites
associated with that feature.

6. On the Prerequisite Validation page, click Next.

Note: This page closes automatically if there is nothing to review.
7. On the Settings page, specify the following settings:
a. Microsoft Dynamics SL System Database connection information section:

i In Database server, type the name of the Microsoft SQL server to which you want to
connect.

ii If you use Windows Authentication, click to select the Use Windows authentication
check box. If you use SQL Authentication, click to clear the Use Windows
authentication check box, and then specify the User name and Password of the SQL
server user. For more information, see User Account Requirements on page 10. iii. To use
Secure Sockets Layer (SSL) for encryption, click to select the Encrypt connection check
box. This encrypts the data that is transmitted between the instance of SQL server and
Management Reporter 2012 services.

Note: You must configure SSL on the server and install certificates before you can use
this option. For more information, see “Encrypting connections to SQL server” on MSDN
(http://go.microsoft.com/fwlink/p/?LinkId=294718).

iii In Database, select the Microsoft Dynamics SL system database to which you want to
integrate.

b. Data Mart connection information section:
- Database server - The server where the data mart database is located.

« User name and password of the account that is used to create the data mart database.
Select Use Windows authentication to use your current credentials.

+ Database - The name of the data mart database to which you want connect.

c. Click Next. You may be prompted to provide credentials that have sufficient permissions to enable
SQL Server Change Tracking, such as a user who has a role of db_owner or a system administrator.
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8. Review the configuration summary information, and then click Configure.

Ready to Configure

guration

Management Reporter Application Service
Microsoft Dynamics SL Data Mart

Management Reporter Process Service

9. When the data mart adapter is successfully configured, click Close.

il Configure Management Reporter . .-_LDJEI

Ready to Configure

r Configuration y

v/ Management Reporter Application Service
v/ Microsoft Dynamics SL Data Mart

v/ Management Reporter Process Service

Close |
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10. To integrate with another Microsoft Dynamics SL system database, repeat steps 1 through 9. To
integrate with another ERP system, see the integration guide for that system.

11. After you configure all integrations, you must enable the integrations.

Enable the Data Mart Integration and Import Companies

After you have installed Management Reporter 2012 services and integrated with a Microsoft
Dynamics SL system and enabled the data mart integration, the company information from the
Microsoft Dynamics SL database is automatically imported into Management Reporter 2012.

Note: If you are upgrading from an earlier version of Management Reporter, any companies that you
had integrated in earlier versions of Management Reporter are automatically imported when you
configured the data integration by following the steps starting on page 11.

1. In the Management Reporter 2012 Configuration Console, verify that the application service and
the process service are running.
Note: If you are upgrading from an earlier version of Management Reporter 2012, you must
upgrade the Management Reporter database and the data mart database before you start the
Process Service. Start the Process Service after the upgrade of the Management Reporter
database and after the integration process.
| i Management Reporter 2012 ConfigurationConsole =1ol x|
File Help "
2l héanca:::::;:epomrmmes Fb Management Reporter Services
| Jy ERP Integrations f =
N _h.:i Lugs, i SQLSRVR105 (DemoSystem) to SQLSRVR 105 (ManagementReporterDM) M t Reporter Sesvices
~ ) Dsta Mart Integration
i:‘x Deployment »™ Reporter 2012 ication Service - Running Remove Application Service
§l service 2 Stop;]iRestart Remove Process Service
{ P ) Mz{l:?eme;n:oiepor;eels :Z:-tu Process Service - Running
Database connection:
SQLSRVR 105 (ManagementReporter)
Service account:
Contoso\TUser 1
~  Companies
‘Description Name  Source System
Refresh Companies
~ ERP Integrations
Select Configure from the File menu to add additional ERP integrations.
Task List
Enable the SOLSRVR 105 (Ds ) to SOLSRVR 105 (ManagementReporterDM)
intearation. =i
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2. In the navigation pane of Management Reporter 2012 Configuration Console, expand
Management Reporter Services, and then expand ERP Integrations. Select the integration
from which you want to import companies.

A Management Reporter 2012 Configuration Console B =10 ‘L‘
File Help
=] ;i Management Reporter Services
1 3 Companies ‘ y SQLSRVR105 (DemoSystem) to SQLSRVR105 (ManagementReporterDM)
Ll = i ERPIntegrations
SQLSRVR 105 (DemoSystem) to SQLSRVR 105 (ManagementReporterDM)
= 'b,: Logs Trying to connect to the Management Reporter application service at endpoint:  http://sqlsrvr105:4712
. H Data Mart Integration Last time everything was fully integrated: Not yet run. R
B Depioyment Last time an integration occurred: Not yet run. _ : :
?‘x—.‘ . pyen Last time ERP validation occurred: Not yet run. Update Microsoft Dynamics SL credentials
& Service Reconfigure change tracking
Run ERP data validation
Update data mart credentials
Status: Initial integration has not started.
Enable Integration| Disable Validationl
Notification settings
@ Don't send SMTP server: E-mail from:
€ Send a summary immediately I I
C Ser
Senda summary daily SMTP port: £-mal to:
€ Send a summary weekly
Save Settingsl [25 I
Task List
Enable the SQLSRVR 105 (DemoSystem) to SQLSRVR 105 (ManagementReporterDM)
integration.

3. If you use a data mart integration, the Management Reporter 2012 Configuration Console
automatically reviews the data in your ERP for inconsistent or invalid data, to prevent inconsistent

or invalid data in Management Reporter. The ERP data validation begins automatically after you
create the integration. We recommend that you fix any data issues before you enable the
integration. For more information, see the Management Reporter installation guide.

4. In the display pane, click Enable Integration.

5. The integration of data begins. Information will change on the screen. The values next to the titles
Last time everything was fully integrated, Last time an integration occurred, and Last
time ERP validation occurred will change. When the information displays a date and time, the
initial integration is completed. This includes the import of the companies.

Note: If any of these labels are not updated, verify that the application service and the process
service are running.
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6. When everything is fully integrated, click the Companies node, and then click Refresh

Companies.
i Management Reporter 2012 Configuration Console o =10l x|
File Help
B § Management Reporter Services @ )
1) Companies {§ Companies
Bl 4 ERP Integrations
4 SQLSRVR105 (DemoSystem) to SQLSRVR 105 {Management DM)
B § Logs Description Name  Source System
&l Data Mart Integration Graphic Design Insttute:Demo [ 0010 | Management Reporter data mart
,h‘] Deployment Humongous Insurance:Demo 0020 | Management Reporter data mart
B senvice Contoso, Ltd:Demo 0060 | Management Reporter data mart
Coho Vineyard:Demo 0070 Management Reporter data mart
Coho Winery:Demo 0080 | Management Reporter data mart
Delete Company
Task List |
1

Note: The imported companies are listed in the navigation pane of Management Reporter 2012
Configuration Console, in the Companies node under Management Reporter Services.

7. Close Management Reporter 2012 Configuration Console.

After you successfully complete the integration, install the Management Reporter 2012 client
components. For more information and installation procedures, see the Management Reporter
installation guide.
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Remove an Integration
To remove an existing integration, use the Management Reporter 2012 Configuration Console.

i Management Reporter 2012 Configuration Console i = ]Dlll

File Help

= 3 Management Reporter Services
§) Companies ‘ SQLSRVR105 (DemoSystem) to SQLSRVR105 (ManagementReporterDM)

B Jy ERPIntegrations
4 SQLSRVR105 (DemoSystem) to SQLSRVR 105 (ManagementReporterDM) y o . .
=] @ Logs Trying to connect to the Management Reporter application service at endpoint:  http://sqlsrvr105:4712
o ’T Data Mart Integration Last time everything was fully integrated: Remove
% y e Last time an integration occurred:
%‘ Dep{oyment Last time ERP validation occurred: Not yet run. Update Microsoft Dynamics SL credentials
U s Reconfigure change tracking
Run ERP data validation
Update data mart credentials
Status: Initial integration is complete. Pericdic integrations will occur.
Disable lntegrationl Disable Validation |
Notification settings
@ Don't send SMTP server: E-mail from:
€ Send a summary immediately | |
€ Send a summary daily SMTP port: E-mail to:
C Senda summary weekly
Save Settings. IZS I
Task List
1. Open the Management Reporter 2012 Configuration Console.
2. Expand Management Reporter Services, and then expand ERP Integrations.
3. Click to select the integration that you want to remove.
4. On the right side, click Remove and then confirm that you want to remove the integration.
5. When the removal is complete, the integration is removed from the ERP Integrations list.
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Specify the Default Company

The first time that you open Report Designer, you are prompted to designate a default company that
identifies the source of data for reporting. This name appears in the headings of reports that you
create in Management Reporter.

1. Click Start, point to Programs, point to Microsoft Dynamics, point to Management Reporter
2012, and then click Report Designer.

2. On the Company menu, click Companies to open the list of companies in Management Reporter.

Select the company that you want to assign as the default company, and then click Set as
defaulit.

Companies:
| Company Name /| Company Description Modify... I
0010 Graphic Design Institute:Demo
View
0020 Humongous Insurance:Demo
0060 Contoso, Ltd:Demo Set As Default I
0070 Coho Vineyard:Demo

0080 Coho Winery:Demo

Close I

4. 1If you use the legacy data provider, consider the following:

- If you use Windows authentication, click to select the Use Windows authentication check
box, specify the Windows user name (defaults from the currently logged in Windows user, in
the domain/username format) and the Windows user password.

« If you use SQL authentication, click to clear the Use Windows authentication check box,
specify the Microsoft Dynamics SL user name and password. These credentials must match the
credentials stored in the Microsoft Dynamics SL database.

5. Click Close.
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Appendix
Available Attributes

The following attributes are available when you create reports from Management Reporter 2012.

Account Type
» Acct_Cat - Account Category

* AcctType - Account Type

+ Active - Account Active Status

+ ClassID - Account Class ID

+ ConsolAcct - Account Consolidation Account
+ RatioGrp - Account Ratio Group

+ UnitofMeas - Account Unit of Measure
+ Userl - Account User 1

* User2 - Account User 2

* User3 - Account User 3

* User4 - Account User 4

* User5 - Account User 5

+ User6 - Account User 6

* User7 - Account User 7

. User8 - Account User 8

Transaction Type
* Balance Type - Transaction Balance Type

+ BatNbr - Transaction Batch Number

« CpnyID - Transaction Company ID

+ CrAmt - Transaction Credit Amount

e CuryCrAmt - Transaction Currency Credit Amount
¢ CuryDrAmt - Transaction Currency Debit Amount
* CuryEffDate - Transaction Currency Effective Date
e Curyld - Transaction Currency ID

«  CuryMultDiv - Transaction Currency Operation

+ CuryRate - Transaction Currency Rate

* CuryRateType - Transaction Currency Rate Type

+ DrAmt - Transaction Debit Amount

+  Employee ID - Transaction Employee ID

+ GLTranDate - GL Transaction Date

* JrnlType - Transaction Journal Type

« Labor_Class_Cd - Transaction Labor Class
21
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« LineRef - Transaction Line Reference

* Module - Transaction Module

» OrigAcct - Transaction Originating Account

* OrigBatNbr - Transaction Originating Batch Number

+  OrigCpnyID - Transaction Originating Company ID

» OrigSub - Transaction Originating Sub Acct

 PC_Flag - Transaction PC Flag

. PC_ID - Transaction PC ID

+ PC_Status - Transaction PC Status

« PerEnt - Transaction Period Entered

*  ProjectID - Transaction Project ID

* Qty - Transaction Quantity

« RefNbr - Transaction Reference Number

+ TaskID - Transaction Task ID

+ TranDesc - Transaction Description

« TranType - Transaction Type

+ TranUserl - Transaction User 1

+ TranUser2 - Transaction User 2

+ TranUser3 - Transaction User 3

+ TranUser4 - Transaction User 4

+ TranUser5 - Transaction User 5

+ TranUser6 - Transaction User 6

+ TranUser?7 - Transaction User 7

+ TranUser8 - Transaction User 8

* Units - Transaction Units

Reporting When the Last Two Periods End on the Same Date

In MR 2012 CU9, if the last two periods of your fiscal year end on the same date, the data for these
two periods is combined and reported as the first of the two periods. Beginning with MR 2012 CU10,
the data for these two periods is no longer combined. You no longer need to use column restrictions of
XAD and ADJ. With this change comes a slight adjustment to the period ending dates, as reported by

Management Reporter. Two periods cannot end on the same date in Management Reporter; so the
first of the two periods’ ending date is adjusted by one day.

For example, you have set up period 12 and period 13 so that both periods end on 12/31. In MR 2012
CU9, all data for these two periods is reported as period 12 data, and period 13 data is recorded as
adjustments to period 12. Beginning with MR 2012 CU10, period 12 data is reported in period 12 and
period 13 data is reported in period 13. Note that the ending date of period 12 is now 12/30 (not
12/31) and the ending date for period 13 remains 12/31.

The following sections provide additional information about the Microsoft Dynamics SL data mart
adapter.
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Data Mart Displays Only Attributes Associated with Transactions

In earlier versions of Management Reporter, legacy data providers displayed all attribute values that
were listed in the ERP database, regardless of context or functionality. This included attributes that
were not associated with transaction data.

When you use a data mart integration, Management Reporter 2012 now displays only the attribute
values that are associated with a transaction. This improves report creation and data analysis.

Supported Attributes

You can select attribute filters to include additional account and transaction information on reports in
Management Reporter. Select attributes to filter in row or column definitions and to display in the
columns. See Management Reporter Help documentation for more information about filters in
attributes.

Drill to Dynamics from the Web Report Viewer

Drill to Dynamics is now available from the Management Reporter Web Report Viewer. Be aware of the
following items when you use this feature from the Web Report Viewer:

+ The Period From and the Period Thru that are passed to the Account/Subaccount Detail Inquiry
(01.303.00) screen are the range of fiscal periods from 01 to the report’s base fiscal period. If you
need to, you can change these period numbers after the screen opens.

*  You must click Refresh in the Account/Subaccount Detail Inquiry (01.303.00) screen so that the
financial data appears.

«  Drill to Dynamics from the Web Report Viewer is supported with Microsoft Dynamics SL 2011
Feature Pack 1 (FP1) and later versions.
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